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FreeDOS Installation CD Version 0.95 Beta 
 

1. Installing FreeDOS (or MSDOS) on a WindowsXP 
Computer 

You can install FreeDOS (or MSDOS) on almost any WindowsXP computer in under an 
hour and WITHOUT having to reinstall WindowsXP!  This procedure will show you 
how to dual-boot your computer.  When you are done, you will see a screen like Figure 
1-1 when you boot your computer and you can choose whether to run DOS or Windows! 
 

 
Figure 1-1 Initial Boot Screen (GAG Boot Loader) 

 
All you need is access to a high-speed internet connection to download a 40 MByte CD 
image, a CD burner, and a blank CD. 
 
Your computer must be able to boot from a CD drive…almost all modern computers 
can…and boot from an IDE or SATA hard disk drive.  If you are using a SCSI drive or a 
RAID array, this technique may not work for you. 
 
You can use this procedure to install either FreeDOS or MSDOS 7.1.  The installation 
CD includes FreeDOS.  MSDOS installation is described in Section 7.1. 
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1.1. Overview of the Procedure 
The most current version of this procedure can probably be found at 
http://johnson.tmfc.net/dos/.  Click on “Add dos to preinstalled Windows” on the left 
side. 
 
There are five basic steps necessary to install FreeDOS on your WindowsXP computer. 
 

1. Shrink the WindowsXP disk partition by 500 Mbytes (a trivial amount). 
2. Create a new partition of type Windows 95 FAT32 (LBA) 
3. Install and configure the GAG boot loader 
4. Boot DOS and do a “sys” command to install it on the new partition 
5. Copy some basic DOS files to the new partition and create autoexec.bat and 

config.sys files. 
 
Everything you need to do this and install FreeDOS is available on a single bootable CD 
which you can download for free. 

1.2. FAQ (Frequently Asked Questions) 
 
1.  Why don't you just use the official Microsoft procedure for dual-booting Windows XP 
and DOS? 
 
For the Microsoft procedure, see: 
http://www.microsoft.com/windowsxp/using/setup/learnmore/multiboot.mspx 
 
The Microsoft procedure works fine.  However, it requires destroying the existing 
Windows XP installation, installing DOS, and then reinstalling Windows XP.  The 
computers I am dealing with have Windows XP pre-installed and I am not willing to 
destroy the existing installation.  This procedure adds DOS without affecting the 
Windows XP installation. 
 
2. Why don't you just use a commercial package to re-partition the disk and dual boot? 
 
I used to use Partition Magic for this.  However, Partition Magic 8.02 did not successfully 
resized most of the NTFS partitions I tested it with so I sent it back.  Also, Partition 
Magic's license agreement required buying a separate license for each computer I wanted 
to dual boot.  The open source tools I am using, including ntfsresize, GParted, and the 
GAG boot loader, are stable and widely used by people who want to dual-boot Linux and 
Windows XP.  They are also available free. 
 
I have no experience with other commercial packages. 
 
4.  The installation CD uses Linux!  Won’t I have to install Linux on my hard disk too? 
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No.  This is a Linux LiveCD.  You just insert it in the CD-Drive and reboot.  It runs 
strictly from the CD and memory and does not need the hard drive at all.  You won't even 
know it's Linux except that it doesn’t look like Windows. 
 
There is a whole family of what are called "Linux Live" CD's that run strictly from CD.  
They allow you to run Linux without touching the hard disk AT ALL in ANY WAY.  
And, they are very cool! 
 
The only OS's the hard drive will contain are Windows XP and DOS. 
 
5. My computer already dual boots Windows and another operating system (perhaps 
Windows XP and Windows 98).  Should I use this procedure? 
 
Probably not.  If your computer is currently configured to dual boot and is meeting your 
needs, there is no advantage to re-partitioning your disk drive using this procedure.  Also, 
DOS requires a PRIMARY disk partition.  There can only be three or four of these on a 
disk.  Laptops often have a “maintenance” partition as the first primary partition and 
WindowsXP as the second primary partition.  If you have another operating system, you 
may not be able to create a primary partition for DOS. 
 
6.  Why doesn’t the installation CD include an MS-DOS bootable image?  There are 
plenty of MS-DOS images available on the world wide web. 
 
MS-DOS is a proprietary Microsoft Operating System and I cannot legally redistribute it.  
You need a valid license to run it on your computer.  This may be an MSDOS license, a 
Windows98 license, or an EULA (End-User License Agreement) for another operating 
system with a “downgrade” or “upgrade” right.   
 
You can get all of the files you need easily from the web to do the installation, and you 
do not need any license or installation keys, but you do need a license to run it legally.  I 
have transferred several Windows98SE licenses from old, broken computers. 
 
I will tell you how to get the necessary disk image for MS-DOS 7.1 in Section 7.1. 

2. Before you begin 
Most desktop partitions delivered with Windows XP pre-installed have one NTFS 
partition which takes up the entire disk.  Some desktop computers, and most laptop 
computers, have a small, often hidden, system partition on the disk before the NTFS 
partition.  Do NOT, under any circumstances, modify, format, resize, relabel, or 
otherwise modify that partition!  Do not reformat or relabel the NTFS partition either! 

2.1. Caution!!! 
NOTE: You should DEFINITELY have a backup of the data on your computer BEFORE 
you perform this procedure. 
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I am going to provide a very detailed procedure.  However, if you are not comfortable 
with installing programs and rebooting your computer, you may want to get someone to 
help you with this. 
 
You will have to burn “ISO” file images to a CD so that the CD is bootable.  There are 
various ways to do this. 

3. Creating the FreeDOS Installation CD 
Go to http://johnson.tmfc.net/dos/file/fdinst095.7z.  Download the fdinst095.7Z file and 
save it to your desktop.  This file is about 30 Mbytes (Megabytes).  You will need the 
7Zip program to decompress the file – you can get this program from http://www.7-
zip.org/.  You probably need to get the “32-bit Windows MSI” file. 

3.1. Uncompressing the fdinst094.7Z file 
“.7Z” is a compressed file format similar to the popular “.zip” files.  It uses a program 
called 7Zip for decompressing it.  Download 7Zip from www.7zip.org (get the 32-Bit 
Windows MSI file unless you know you need another one) and double click on it to 
install 7Zip.  Now, right-click on the fdinst094.7Z file and select “7-Zip->Extract Here” 
(See Figure 3-1).  This will create a file called fdinst095.iso, which is in the format 
required to create a bootable CD. 
 

 
Figure 3-1 Uncompressing fdinst094.iso 
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3.2. Burning the FreeDOS Installation CD 
You may have CD creation software on your computer that will burn an ISO image to 
CD and create a bootable CD.  For example, Easy CD Creator (Roxio) will do this.  If 
not, you can download the “Power Toy” from the Web and use that to burn the CD under 
Windows XP.  For more information, see the Appendix of www.k1ea.com/hints, 
“Creating a Bootable DOS CD.”  Label the CD “FreeDOS Installation CD Version 0.94.”   
 
If you see the file fdinst094.iso on the CD (from Windows), you did not burn the CD 
correctly and it will not boot.  You should a directory called ISOLINUX and a file 
gparted on the CD (Figure 3-2). 
 

 
Figure 3-2 Directory of free installation CD 

4. Resizing your NTFS Partition 
Put the CD you just created in your computer’s CD drive and reboot.  Type “linux” at the 
“boot:” prompt (Figure 4-1)  (or just wait ten seconds). 
 

 
Figure 4-1 Enter “linux” at the Initial Boot Prompt  

 
You will have to select several items while the GParted LiveCD is booting, including the 
XVesa screen server, language, keymap, screen resolution, and screen depth.   
 
In the first screen, use the arrow keys to highlight the “XVesa” module (Figure 4-2) and 
press the return key to select “OK”.  The same screen will reappear.  Select “Done” 
(Figure 4-3).  Select the appropriate language and keymap (Figure 4-4).  Select 1024x768 
resolution and a screen depth of 24 (Figure 4-5). 
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Figure 4-2 Select XVesa xserver 

 
Figure 4-3 “Boot with extra selected 

options.” 
 

 

 

Figure 4-4 Selecting Language and Keymap 
 

  
Figure 4-5 Selecting Screen Resolution and Screen Depth 

5. Repartitioning the Disk 
NOTE: This procedure should work fine for other types of Windows partitions, including 
FAT32, used by older Windows versions.  If you have a FAT32 partition, first use the 
Windows XP utility “Disk Defragmenter” to defragment it.  This is available under 
“Start->All Programs->Accessories->System Tools->Disk Defragmenter.”  This step is 
not necessary if you have an NTFS partition.  Thanks to Paul Erickson, VA7NT, for 
verifying that this works! 
 
NOTE: Ed Parish, K1EP, got the following error: “Filesystem check failed…”  If you get 
this error, it indicates that the NTFS partition has at least one error.  You can fix this by 
booting Windows XP, bringing up a “Command Prompt” (Start->All Programs-
>Accessories->Command Prompt) and entering “chkdsk /f c:” at the C:> prompt.  
You will have to reboot your computer. 
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Now, let’s repartition your disk.  The LiveCD starts the GParted program.  When it 
finishes booting, and GParted finishes scanning your disks, you should see a screen very 
similar to Figure 5-1.  Your disk may have different partitions. 
 

 
Figure 5-1 Hard Disk Partitions before repartitioning 

 
You should see one or two partitions of the form /dev/hda1 and /dev/hda2 (or /dev/sda1 
and /dev/sda2).  One of these will be a LARGE NTFS partition, like is shown in Figure 
5-2.  Notice also that the “boot” flag is shown for the NTFS partition.  This means that 
this partition will be booted when the computer is started and is thus your WindowsXP 
partition. 
 
Note that there is a smaller FAT32 partition on this hard drive.  This is a recovery 
partition that HP put on this particular computer.  Your computer may not have a 
recovery partition.  If you do have a recovery partition, don’t do anything with this 
partition.  If you DO NOT see only one or two partitions, with the LAST partition being a 
large NTFS partition with the “boot” flag, do not continue with this procedure unless you 
are SURE that you know what you are doing. 
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Figure 5-2 FAT32 recovery and NTFS Partitions 

 
Next, we need to shrink the NTFS partition by 500 MiB (Mibibytes).  This is an 
insignificant amount that you will never notice, but is plenty of room for a DOS 
installation!  To shrink the partition, select it with the left mouse button (it will be 
highlighted) and then click the right mouse button.  This must be the large NTFS partition 
with the “boot” flag.  Select “Resize/Move” (Figure 5-3). 
 

 
Figure 5-3 Menu for resizing partitions 

 
The resize dialog shown below will appear.  Enter 500 in the “Free Space Following 
(MiB):” block (Figure 5-4).  You will have to press “Return” to get the New Size to 
update also.   
 
NOTE:  The partition /dev/hda2 needs to be the NTFS partition marked with the boot 
flag.  It may be /dev/hda1 on your computer if there is not a rescue or recovery partition 
on your disk drive.  It must be the LAST partition on your disk drive. 
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Figure 5-4 Resizing dialog window 

 
Press the “Resize/Move” button in the panel using the left mouse button.  The GParted 
window will look like Figure 5-5, with the “Resize” operation listed and 500 Mbytes of 
“Unallocated” space. 
 

 
Figure 5-5 GParted window after resizing the NTFS partition. 

 
Select the unallocated space with the left mouse button and with the right mouse button, 
select “New” to create a new partition (Figure 5-6). 
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Figure 5-6 Selection of unallocated space. 

 
Under “Filesystem”, select “fat32”.  Verify that it will be created as a Primary Partition 
with a New Size (MB) of 500.  Notice that the partition outline changed color from blue 
to green when the type was changed from ext2 to fat32 (Figure 5-7). 
 

 
Figure 5-7 Creating a new FAT32 Primary Partition 
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Select “Add” in the Create new Partition panel (Figure 5-7).  GParted should appear as 
shown in Figure 5-8, with the new fat32 partition shown after the NTFS partition and two 
operations in the panel below the partitions. 
 

 
Figure 5-8 New FAT32 partition shown in GParted window 

 
You have not actually repartitioned the disk yet.  You can select GParted->Quit and 
nothing will be done to the disks. 
 
Are you sure that you have a backup of any critical data from the hard disk?  If so, go to 
the top toolbar and select the green check mark, labeled “Apply.”  Select the Apply 
button in the dialog box (Figure 5-9). 
 

 
Figure 5-9 Dialog box for repartitioning 



FreeDOS Installation CD Version 0.95 Beta 
November 29, 2006 

12 

 
You will see a progress indication and then “All operations successfully completed.”  
Click “Close” in the Apply pending operations window (Figure 5-10). 
 

 
Figure 5-10 Partitioning progress dialog box 

 
When you are done, GParted will show the new partition as either /dev/hda2 or /dev/hda3 
as shown in Figure 5-11. 
 

 
Figure 5-11 Partitions after repartitioning. 

 
Finally, we need to set the “lba” flag for the new partition.  Select the partition (/dev/hda3 
in this case) with the left mouse button, press the right mouse button, and select “manage 
flags” (Figure 5-12). 
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Figure 5-12 Selecting Manage Flags 

 
Select the “lba” flag by checking the box in the Manage Flags window and then “Close” 
(Figure 5-13). 
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Figure 5-13 Setting the LBA flag for the new partition 

 
The flags column for the new FAT32 partition will now say “lba” as shown in Figure 
5-14. 
 

 
Figure 5-14 LBA flag set for new partition /dev/hda3 

 
In the GParted window, select GParted->Quit to exit GParted (Figure 5-15). 
 

 
Figure 5-15 Quit from the GParted Menu 

 
Select the “Reboot” control in the bottom right corner of the screen (Figure 5-16) and 
select “Eject and Reboot” from the popup menu. 
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Figure 5-16 Rebooting to WindowsXP. 

 
WindowsXP should boot.   
 
WindowsXP is going to run a utility called “chkdsk” in a special screen when it boots.  
Let WindowsXP run this utility and complete a check on its NTFS partition.  After 
Windows boots, if you select the “My Computer” icon, you will see a new disk drive.  
This drive will be of type FAT32 and about 500 Megabytes.  (You can verify the type 
and size by right clicking on the new disk icon (Figure 5-17)).  Note that you can copy 
files to and from this new disk drive from WindowsXP, which is very cool!   
 
NOTE:  At this point you could use the application “WordPad” to create a “txt” file and 
store this file in the new FAT32 partition.  The existence of this file can be used later 
during these instructions, under the section “Installing FreeDOS” at the DOS prompt 
“A:>”, to determine for certain that you are selecting the correct partition into which to 
load DOS. 
 
IMPORTANT:  The drive letter (in this case “G:”) that Windows assigns to this partition 
is usually NOT the same drive letter that DOS will assign.  Do NOT assume that DOS 
will use the same drive letters. 
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Figure 5-17 WindowsXP properties window for the new FAT32 partition  

6. Install GAG Boot Loader 
We are going to install a simple multi-boot loader called GAG.  Put the CD in the CD 
drive of your computer and reboot.  Enter GAG at the boot: prompt (Figure 6-1). 
 

 
Figure 6-1 Boot prompt. 

 
GAG will start (Figure 6-2). 
 
At this point, decide whether you want to install FreeDOS or MSDOS 7.1. 
 
 

 
Figure 6-2 Screen display at the opening of GAG. 

 



FreeDOS Installation CD Version 0.95 Beta 
November 29, 2006 

17 

I will show your keystrokes, with the option you are selecting in parenthesis. 
Enter the following at the screen shown in Figure 6-2: 
 
4 (Install GAG) 
 

 
Figure 6-3 GAG reminder display prior to installing DOS. 

 
Space Bar (Press any key to continue (Figure 6-3)) 
 

 
Figure 6-4 Keyboard selection 

 

 
Figure 6-5 Language selection 

 
1 (QWERTY Keyboard (Figure 6-4)) 
8 (English (Figure 6-5)) – or whatever language you wish of course! 
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Figure 6-6 GAG Boot Manager window for enabling setup for booting an OS 

 
S (Setup (Figure 6-6)) 
 
At this point, you should see the main GAG screen (Figure 6-7). 
 

 
Figure 6-7 GAG Boot Manager task window. 

 
A (Add a new Operating System (Figure 6-7)) 
At this point, you will see the options shown in Figure 6-8.  Note that you may not have 
the B partition that I had on my laptop and B may be your Windows XP Partition. 
 

 
Figure 6-8 Adding WindowXP as a boot option 
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C (Select NTFS Partition…may be B for you (Figure 6-8)) 
 

 
Figure 6-9 Entering OS Name 

 

 
Figure 6-10 Password definition

WindowsXP (Enter Description (Figure 6-9)) followed by carriage return. 
Carriage Return Key (Password…don’t enter one (Figure 6-10)) 
 
At this point, you can select the icon you want for your operating system: 
 

 
Figure 6-11 Icon selection for booting Windows XP 

 
C (Select Windows Icon (Figure 6-11)) 
 
Now, to add DOS to your menu. 
 
A (Add a new Operating System) 
D (Select MSDOS Partition…may be C for you) 
 
MSDOS7.1 (Enter Description) or 
FreeDOS  (Enter Description) - depending on which you are installing 
 
Carriage Return Key (No password) 
E (Select DOS Icon) 
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H (Save in hard Disk) 
Carriage Return Key (Acknowledge message with OK) 
 
Remove the GAG CD and reboot.  You will see the GAG boot loader introduction screen 
(Figure 6-12), with “Windows XP” and “MSDOS71” or “FreeDOS” shown as the 
operating systems. 
 

 
Figure 6-12 Boot Selection Window 

 
Press “2” and verify that WindowsXP boots normally. 
 
NOTE: If you hit “S” for setup, you can add a timer and select an operating system to be 
automatically booted in some number of seconds if you don’t press a key.  If you do this, 
don’t forget to select “H” to save the timer to the hard disk!   

7. Installing FreeDOS 
Note:  Some, perhaps all, FreeDOS installers write to the C: partition regardless of your 
disk setup.  DO NOT use an automated FreeDOS installer unless you are certain it will 
do what you want.  Use the following instructions to install FreeDOS to the correct 
partition on your disk. 
 
Reboot your computer with the FreeDOS installation CD installed.  Enter “FDOS10” at 
the boot: prompt (Figure 7-1). 
 

 
Figure 7-1 Boot prompt 

 
You should get a DOS prompt A:>.  (Figure 7-2) 
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Figure 7-2 DOS prompt. 

 
Do a “DIR C:” to make sure that your new partition is correctly mounted.  There should 
be no files or directories.   
 
Note:  If you had a rescue partition, and your new partition was /dev/hda3, that you may 
see files on C:.  In that case, do a “DIR D:”.   
 
You should see no files and a size of approximately 500 Mbytes.  If this is not what you 
see, do NOT do the next step! 
 
If you followed the suggestion made on page 16 of these instruction, following Figure 24, 
then the file you stored using “Wordpad” will appear.  This will confirm the correct 
partition. 
 
To install DOS, enter “SYS C:” or “SYS D:”, depending on which partition had a size 
of approximately 500 Mbytes and no files. 
 
Now, you need to copy several files to the new partition to make it usable.  I have 
included a batch file to make this easier (install.bat). 
 
You can use the following commands at the A:> prompt.  Note:  I am using D: in this 
example, since that is the drive that DOS assigned on my computer.  If you did a “SYS 
C:”, substitute C: for D: in the commands below. 
 
A:> D: 
D:> a:\install 
 
Remove the CD and reboot. 
 
Select “3” from GAG to boot DOS.  You should get a DOS prompt “C:>.”  You can 
customize the FreeDOS installation of course, and add whatever utility programs, CD-
ROM drivers, etc., that you want. 
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7.1. Installing MSDOS 7.1 
Note:  If you do not have a floppy drive, you will need to use the wbootess disk image to 
create a bootable DOS CD.  See www.k1ea.com/hints, “Creating a Bootable DOS CD” 
for detailed directions on creating a bootable DOS CD if you wish to install MSDOS and 
do not have a floppy disk drive on your computer. 
 
Go to http://www.nerdlabs.org/bootdisks/ and click on wbootess.exe.  Download this 
program to a convenient folder (I used the Windows Desktop).  If you have a floppy 
drive, insert a floppy in the drive, double click on wbootess.exe and select OK in the 
WinImage Self Extractor (Figure 7-3).  This will write the image to the floppy disk in A:. 
 

 
Figure 7-3 Winimage extractor 

 
Boot the computer from the wbootess bootable CD or floppy disk.  You should get a 
DOS prompt A:>. 
 
Do a “DIR C:” to make sure that your new partition is correctly mounted.  There should 
be no files or directories.  Note that if you had a rescue partition, and your new partition 
was /dev/hda3, that you may see files on C:.  In that case, do a “DIR D:”.  You should 
see no files and a size of approximately 500 Mbytes.  If this is not what you see, do NOT 
do the next step! 
 
To install DOS, enter “SYS C:” or “SYS D:”, depending on which partition had a size 
of approximately 500 Mbytes and no files.  
 
You can now install the rest of the DOS files necessary from a floppy disk or boot into 
Windows XP and copy them onto this partition. 
 
You can use the following commands at the A:> prompt.  Note:  I am using D: in this 
example, since that is the drive that DOS assigned on my computer.  If you did a “SYS 
C:”, substitute C: for D: in the commands below. 
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A:> D: 
D:> mkdir DOS71 
D:> copy a:\himem.sys 
D:> copy a:\emm386.exe 
D:> cd DOS71 
D:> copy a:\mem.exe 
D:> copy a:\move.exe 
D:> copy a:\smartdrv.exe 
D:> copy a:\edit.* 
D:> copy a:\format.com 
D:> copy a:\sys.com 
D:> copy a:\fdisk.exe 
D:> copy a:\more.com 
 
Finally, you need to create an autoexec.bat and config.sys file on the D: (or C:) drive. 
 
D:>  cd \ 
D:>  edit autoexec.bat 
 
Now, type in the following lines.  Then save the file (File->Save) and exit the editor 
(File->Quit).  You can access the File menu using Alt-F. 
 
path=C:\;C:\DOS71 
smartdrv a+ c+ 
 
Now, enter the following: 
 
D:>  edit config.sys 
 
Enter the following lines in the config.sys file: 
 
device=himem.sys /testmem:off 
device=emm386.exe noems 
dos=high,umb 
lastdrive=Z 
buffers=20 
files=40 
 
and save the file.   
 
Remove the floppy disk and reboot. Select “3” from GAG to boot DOS.  You should get 
a DOS prompt “C:>.”  You can customize the MS-DOS installation of course, and add 
whatever utility programs, CD-ROM drivers, etc., that you want. 


